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Notice

© Hewlett-Packard Company, 2001. All rights reserved.

Edition: E0801

Hewlett-Packard Company makes no warranty of any 
kind with regard to this material, including, but not 
limited to, the implied warranties of merchantability and 
fitness for a particular purpose. Hewlett-Packard shall not 
be liable for errors contained herein or for incidental or 
consequential damages in connection with the furnishing, 
performance, or use of this material.

This document contains proprietary information, which is 
protected by copyright. No part of this document may be 
photocopied, reproduced, or translated into another 
language without the prior written consent of 
Hewlett-Packard. The information contained in this 
document is subject to change without notice.

Use, duplication, or disclosure by government is subject 
to restrictions as set forth in subdivision (c) (1) (ii) of the 
Rights in Technical Data and Computer Software Clause 
at DFARS 252.227.7013.

Warranty

If you have any questions about the warranty for this 
product, contact your dealer or local Hewlett-Packard 
sales representative.

Trademarks

Brocade, SilkWorm, Brocade Extended Fabrics, Brocade 
Fabric Manager, Brocade Fabric OS, Brocade Fabric 
Watch, Brocade QuickLoop, Brocade Remote Switch, 
Brocade Web Tools, and Brocade Zoning are trademarks 
or registered trademarks of Brocade Communications 
Systems, Inc. in the United States and/or in other 
countries. 

All other brands, product or service names are or may be 
trademarks or service marks of, and are used to identify 
products of services of their respective owners. 

Brocade Extended Fabrics, Brocade Fabric Manager, 
Brocade Fabric OS, Brocade Fabric Watch, Brocade 
QuickLoop, Brocade Remote Switch, Brocade Web Tools, 
and Brocade Zoning are hereafter referred to as Extended 
Fabrics, Fabric Manager, Fabric OS, Fabric Watch, 
QuickLoop, Remote Switch, Web Tools, and Zoning 
respectively.

Safety notices

Any servicing, adjustment, maintenance, or repair must be 
performed only by authorized service-trained personnel.

Format conventions

variable Indicates that you must supply a value.

output Denotes text displayed on the screen.

[ ] Indicates that the enclosed element is 
optional and may be left out.

{ } Indicates that you must specify one of the 
listed options.

| Separates alternatives.

. . . Indicates a repetition of the preceding 
parameter.

Tip Denotes ideas for enhanced product usage.

Note Denotes significant concepts or operating 
instructions.

CAUTION Denotes a hazard that can cause hardware or 
software damage.

WARNING Denotes a hazard that can cause personal 
injury or death.
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PREFACE

Web Tools is supported for switches on Fabric OS a2.4.1 or later.

About This Guide
This guide provides the following information:  

Chapter 1
Introducing Web Tools

Overview of Web Tools and a summary of the 
information available through Web Tools.

Chapter 2
Installing Web Tools

System requirements and instructions for 
installing and launching Web Tools.

Chapter 3
Using Web Tools 

Information about and instructions for using 
each of the windows in Web Tools.
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Related Publications
Related product information can be found in the following publications. 
Those publications with part numbers are provided as printed copies with 
your product. The HP Surestore FC Switch 6164 Documentation CD 
contains all publications listed in the table below and is also provided with 
your product.

Information about fibre channel standards and the fibre channel industry in 
general can be found on the Fibre Channel Industry Association web site, 
located at: 

http://www.fibrechannel.com

Getting Help 
For support information, visit the HP web site located at:

http://www.hp.com

Title Part Number

HP Surestore FC Switch 6164 Documentation CD A7326-11011

HP Surestore FC Switch 6164 Installation and 
Reference Guide

A7326-90902

HP Surestore FC Switch 6164 Quick Start Guide A7326-90901

Distributed Fabrics User’s Guide, version 2.2 Available only on CD

Fabric OS Reference Manual, version 2.4 Available only on CD

Fabric Watch User’s Guide, version 2.2 Available only on CD

MIB Reference Manual, version 2.3 Available only on CD

QuickLoop User’s Guide, version 2.3 Available only on CD

Zoning User’s Guide, version 2.2 Available only on CD
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Getting Software Updates
Firmware and software updates are found on the HP web site located at:

http://www.hp.com 

New switch firmware can be installed from the following host operating 
systems:

• UNIX

• Windows NT

• Windows 2000

• Windows 98

• Windows 95
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1
INTRODUCING WEB TOOLS

Web Tools runs on Fabric OS and provides a graphical interface that allows 
the administrator to monitor and manage entire fabrics and individual 
switches and ports from a standard workstation.

Web Tools provides the following information and capabilities:

• Monitoring of and the ability to manage the entire fabric:

– The status of all switches in the fabric

– Access to event logs for entire fabric

– Zoning functions

– Access to the Name Server Table

– Telnet functions

– Switch beaconing for rapid identification in large fabric 
environments

– Loop diagnostics and query and control of loop interfaces to aid in 
locating faulty devices

– Ability to name and zone QuickLoops
13



• Monitoring of and the ability to manage individual switches:

– Summary information about each switch

– Access to event logs for individual switches

– Switch configuration and administration

– Ability to upgrade Fabric OS and license key administration

– Report capability for switch configuration information

• Monitoring of and the ability to manage individual ports:

– Port status

– Information about Gigabit Interface Converter (GBIC) Serial IDs

– Information about connected devices

– Loop information

– Port performance including frame counts (frames in, frames out) and 
error counts

Views Available in Web Tools
Web Tools provides access to and information about the fabric through a 
number of separate windows, making it possible to view several aspects of 
the fabric at the same time.

Initial Display Upon Launching Web Tools (Fabric View)
Fabric View displays a control panel that provides access to fabric-wide 
options, a panel for each switch in the fabric, plus a legend that explains the 
meaning of the background colors on the Switch icons. Each panel contains 
an icon that represents the switch itself, in addition to icons for Switch 
Events and the Administrative and Telnet interfaces. The background color 
of the Switch icon represents the status of that particular switch or 
Integrated Fabric (as defined by the legend provided in the window).
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Note Switch status is calculated approximately once per second; however 
the initial calculation does not occur until 30–60 seconds after the switch is 
booted. It is calculated from the state of data structures in the switch, and 
stored as the variable “switchStatus”. 

For all statuses that are based on errors per time interval, any errors will 
cause the status to show faulty until the entire sample interval has passed.

Information Accessible from Fabric View

Fabric Events View Displays the error log for the fabric, which is the combination of the error 
logs of all the switches in the fabric. Click the Fabric Events icon on the 
control panel to access.

Fabric Topology View Displays physical configuration, including active domains, paths, and 
routing information. Click the Fabric Topology icon on the control panel to 
access.

Name Server Table
View

Displays the Name Server Table for the fabric. Use to view information 
about the devices attached to the fabric. Click the Name Server icon on the 
control panel to access.

Zone Administration
View

Provides an interface to Zoning, including zone settings, zone aliases, 
QuickLoops, and zone configurations. Click the Zone Admin icon on the 
control panel to access. 

Summary View/Detail
View

Toggles between summarized and detailed versions of Fabric View.

Switch View Displays information about individual switches, including a real-time view 
of switch status. Click the Switch icon on a switch panel to access. The 
Switch View is also the launch point for the Switch Events View, Telnet 
Interface, Fabric Watch View, Administrative Interface, Performance View, 
and Port Information View. It includes icons that display the status of the 
switch fans, temperature monitors, and beacon. 
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Switch Events View Displays the error log for the switch. Click the Events icon on the switch 
panel to access, or access through Switch View (see “Switch Events View” 
on page 16).

Telnet Interface Provides an interface for using Telnet commands for switch diagnostics, 
troubleshooting, and fabric management. Click the Telnet icon on the 
switch panel to access, or access through Switch View (see “Telnet 
Interface” on page 16).

Administrative
Interface

Provides an interface for performing functions such as upgrading firmware 
versions or reconfiguring a switch. Click the Admin icon on the switch 
panel to access, or access through Switch View (see “Administrative 
Interface” on page 17).

Information Accessible From Switch View

Port Information View Displays statistics and status for the selected port, GBIC, or loop. Also 
provides options for managing loops. Click the icon for the relevant port in 
Switch View to access.

Power Supply Status The Power Supply icons on the switch graphic indicate the number of 
power supplies present, and the LED on the power supply indicates the 
status of the power assemblies.

Switch Events View Displays the error log for the switch. Click Events in Switch View to 
access, or access through Fabric View (see “Initial Display Upon 
Launching Web Tools (Fabric View)” on page 14).

Telnet Interface Provides an interface for using Telnet commands for switch diagnostics, 
troubleshooting, and detailed fabric management. Click Telnet in Switch 
View to access, or access through Fabric View (see “Initial Display Upon 
Launching Web Tools (Fabric View)” on page 14).

Fabric Watch View Monitors fabric elements and displays error and performance counter 
status, issuing an alert when conditions are out of acceptable ranges. Click 
Watch in Switch View to access.

Fan Icon The color of this icon indicates the number of fans in the switch that are 
within normal range (see the color legend in Fabric View).
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Administrative
Interface

Provides an interface for performing functions such as upgrading firmware 
versions or reconfiguring a switch. Click Admin in Switch View to access, 
or access through Fabric View (see “Initial Display Upon Launching Web 
Tools (Fabric View)” on page 14).

Performance View Graphically portrays real-time data throughput for each port and displays 
total switch bandwidth utilization. Click Perf in Switch View to access.

Beacon Icon Click to turn the beacon, which is an indicator light on the front panel of the 
switch, on or off. The appearance of the icon indicates whether beacon is 
lit.

Temperature Icon The color of this icon indicates the number of temperature sensors in the 
switch that are within range (see the color legend in Fabric View).
Introducing Web Tools 17
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2
INSTALLING WEB TOOLS

This chapter provides requirements and instructions for installing 
Web Tools.

Requirements
The switch, the workstation and browser must meet specific requirements 
for correct installation and operation of Web Tools.

Switch Requirements
Web Tools 2.3 can manage switches that meet the following requirements:

• 2400, 2800, 6164 switch

• Fabric OS a2.4.1or later installed
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Workstation Requirements
The following items are required the correct installation and operation of 
Web Tools: 

• One of the following operating systems:

– Windows 95, 98, or 2000

– Windows NT 4.0

• Adequate RAM (required for Windows operating systems only):

– 128 MB for fabrics of 21 switches or less

– 256 MB for fabrics containing more than 21 switches

• 5 MB of free disk space

• One of the following web browsers: 

– Netscape Communicator 4.51 or later

– Internet Explorer 4.01 or later

Note The browser must be configured to work with Web Tools. For 
information about how to do this, see “Installing a Web Browser” on 
page 21.

• The correct version of the Java Plug-in for the operating system:

– Windows 95, 98, NT, or 2000: Java Plug-in version 1.2.2-007 or later

Installation
Do the following to prepare to use Web Tools to manage your fabric:

• Install one of the supported web browsers on the workstation, if not 
already installed.

• Configure the web browser for use with Web Tools.

• Install the required Java Plug-in on the workstation, if not already 
installed.
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Installing a Web Browser
If not already installed, install one of the following browsers:

• Netscape Communicator 4.51 or later (available at 
http://www.netscape.com).

• Internet Explorer 4.01 or later (available at http://www.microsoft.com).

Configuring the Web Browser
Correct operation of Web Tools with either Netscape Communicator or 
Internet Explorer requires specific browser settings. 

Configuring Netscape Communicator
You must clear the web browser cache after installing Fabric OS a2.4.1. 
Some browsers use local cache copies of jar files and/or image files to 
improve performance (depending on the options selected in the browser), 
which can corrupt display in Web Tools.

To remove cached files from Netscape Communicator:

1. Select Edit > Preferences. 

2. Click Advanced in the left text box to expand it, then click Cache.

3. On the Cache panel, click Clear Memory Cache.

4. Click Clear Disk Cache.

5. Click OK.

6. Exit and relaunch the browser.

Configuring Internet Explorer
You must clear the browser cache after installing Fabric OS a2.4.1. The 
browser may use local cache copies of jar files and/or image files to 
improve performance (depending on the options selected in the browser), 
which can corrupt display.
Installing Web Tools 21
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To remove cached files from Internet Explorer:

1. Select View>Internet Options if using Internet Explorer 4.x, or from the 
Tools >Internet Options if using 5.x.

2. Select the General tab and click Delete Files... (under “Temporary Internet 
Files”). 

3. Click OK, then exit and relaunch the browser.

You must also specify the appropriate settings for browser refresh 
frequency.

Browser pages must be refreshed at every visit to ensure the correct 
operation of the Switch Admin feature.

To set the refresh frequency:

1. Select View>Internet Options if using Internet Explorer 4.x, or from the 
Tools>Internet Options if using 5.x.

2. Select the General tab and click Settings (under “Temporary Internet 
Files”). 

3. Under “Check for newer versions of stored pages”, select “Every visit to 
the page”.

Finally, you must select the correct Browser Process Model. 

To select the Browser Process Model:

1. Select View > Internet Options if using Internet Explorer 4.x, or Tools > 
Internet Options if using Internet Explorer 5.x.

2. Select the Advanced tab and click to expand the Browsing category.

3. Under “Browsing”, select “Browse in a new process” if using Internet 
Explorer 4.x, or “Launch browser windows in a separate process” if using 
Internet Explorer 5.x.
22 Web Tools User’s Guide



Installing the Java Plug-in on the Workstation
A Java Plug-in must be installed on the workstation for the correct 
operation of Web Tools. The required version depends on the operating 
system. 

Installing the Java Plug-in on Windows 2000 or NT
Windows 95, 98, 2000 and NT workstations require Java Plug-in version 
1.2.2-007 or later. 

To determine the version of the Java Plug-in installed on Windows 98, NT, 
or 2000, and install if necessary:

1. Launch the Java Plug-in Control Panel from Start > Programs > Java 
Plug-in Control Panel and turn on the Java Console.

2. Launch the web browser, enter the name or IP address of a switch running 
Fabric OS a.2.4.1 or later, and press Enter. 

3. The switch launches the Java Plug-in console, which displays the Java 
Plug-in version currently installed.

4. Determine whether the correct Java Plug-in version is installed, and install 
if necessary:

– If the correct version is installed, Web Tools is ready to use. 

– If no Java Plug-in is installed, point the browser to a switch running 
Fabric OS a2.4.1, follow the link to the Sun Microsystems web site, 
download the correct Java Plug-in, and double-click the downloaded 
file to install the plug-in.

– If an outdated version is currently installed, uninstall it, relaunch the 
browser, enter the address of a switch running Fabric OS a2.4.1 or 
later, follow the link to the Sun Microsystems web site, and 
download the new Java Plug-in.
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Launching Web Tools
You can launch Web Tools once the Java Plug-in is installed on the client 
machine.

To launch Web Tools:

1. Launch a web browser.

2. Enter the switch name or IP address in the Location/Address field 
(for example: http://switchname/) and press Enter.

Web Tools launches, displaying the Fabric View. 
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3
USING WEB TOOLS

This chapter describes the views and interfaces available through Web 
Tools.

Note Switches can be accessed through different methods, such as through 
the Front Panel, Telnet, SNMP, and the web, any of which can occur 
simultaneously. To verify that modifications are correctly applied, ensure 
that the switch is modified from only one connection at a time.

Fabric View
The Fabric View is the first web page that displays when you connect to a 
switch, and it provides access to specific information about each switch, in 
addition to other options and a legend explaining the colors used to indicate 
switch status. Every switch in the fabric is represented by a switch panel in 
Fabric View.
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To launch Web Tools and access Fabric View:

1. Launch a web browser.

2. Enter the switch name or IP address in the Location/Address field and 
press Enter. For example: http://switchname/. 

Note This switch is assumed to be the local domain. For information 
specific to a QuickLoop to be available, the QuickLoop switch must be 
the host domain.

Web Tools launches, displaying Fabric View.

Following is a description of the items visible in Fabric View. 

The Control Panel (left side of Figure 1)

Fabric Events Click to open Fabric Events View (for information about this view, see 
“Fabric Events View” on page 29).

Fabric Topology Click to open Fabric Topology View (for information about this view, see 
“Fabric Topology View” on page 31).

Figure 1. Fabric View
26 Web Tools User’s Guide



Name Server Table Click to open Name Server Table View (for information about this view, 
see “Name Server Table View” on page 34).

Zone Admin Click to open Zone Administration View (for information about this view, 
see “Zone Administration View” on page 36).

Summary/Detail View Toggle to view either the Summary or Detail version of Fabric View. The 
Summary version shows abbreviated switch panels (see Figure 2). The 
default view is Detail.

Status Legend Defines meaning of colors visible in the background of the switch icons. 
Each color indicates a different operational state:

• Green Healthy

• Yellow Marginal (mix of good and faulty readings)

• Red Down (more than two faulty readings)

• Gray Unknown or unmonitored

If no data is available from a switch, the most recent background color 
remains displayed.

Note For all statuses that are based on errors per time interval, any errors 
will cause the status to show faulty until the entire sample interval has 
passed.

The Switch Panel (right side of Figure 1)

Switch Click to open Switch View for the switch. Each switch type is represented 
by a different icon. The background color around the icon indicates the 
status of the switch (for information about this view, see “Switch View” on 
page 46).

Events Click to open Switch Events View to display the switch events log (for 
information about this view, see “Switch Events View” on page 51).

Admin Click to open Switch Administration View (for information about this view, 
see “Administrative Interface” on page 74).
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Telnet Click to launch the Telnet interface for the switch (for information about 
this view, see “Telnet Interface” on page 93).

polled at: or
unreachable since:

Time of the last status check, or if currently unavailable, the time of the last 
successful status check.

Name: The name of the switch.

Fabric OS version: Version of Fabric OS installed on the switch.

Domain ID: A number that uniquely identifies the switch within the fabric.

Ethernet IP: Ethernet IP address.

Ethernet Mask: Ethernet subnetmask.

FCnet IP: Fibre channel IP address.

FCnet Mask: Fibre channel subnetmask.

Gateway IP: Gateway IP address.

WWN: Unique numeric identifier for the switch; assigned by manufacturer.
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Following is a picture of Fabric View with the Summary View selected:

Fabric Events View
The Fabric Events View provides a running log of events for all switches in 
the fabric. 

To access Fabric Events View:

1. Launch a web browser.

2. Enter the switch name or IP address in the Location/Address field and 
press Enter. For example: http://switchname/.

Web Tools launches, displaying Fabric View.

3. Click Fabric Events.

Figure 2. Summary Version of Fabric View
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Note To sort the events by a particular column, click the column header. 
To resize a column, drag the column divider.

Following is a description of the columns in the Fabric Events view:  

Figure 3. Fabric Events View

Switch Name of switch

Num... (number) Event number for affected switch

Time Time of event

Count Number of consecutive occurrences of same event

Level Severity level of event:
0     panic (switch reboots)
1     critical
2     error
3     warning
4     information
5     debug

Message Description of event
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Fabric Topology View
The Fabric Topology View summarizes the physical configuration of the 
fabric from the perspective of the “local domain” (the domain of the switch 
entered as a URL in the web browser). This includes information about the 
“destination domains” (all other domains in the fabric) and the paths 
between each destination domain and the local domain.

To access Fabric Topology View:

1. Launch a web browser.

2. Enter the switch name or IP address in the Location/Address field and 
press Enter. For example: http://switchname/.

Note The switch entered into the web browser is identified by Web 
Tools as the local domain.

Web Tools launches, displaying Fabric View.

3. Click Fabric Topology.

The Fabric Topology View displays.

Figure 4. Fabric Topology View
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The window can be scrolled downwards to display information about 
the individual paths between the local switch and each of the other 
switches in the fabric.

Following is a description of the fields in the Fabric Topology View: 

Figure 5. Fabric Topology View, Scrolled Downwards

View Fabric Topology 
from Switch [switch 
name]:

Lists the switch in the domain that is assumed to 
be the local domain.

There are a total of [n] 
domains in the fabric.

The number of domains in the fabric.

Local domain ID: A number that uniquely identifies the local 
switch within the fabric, and the name of the 
switch.

Domain ID: (may be 
more than one)

A number that uniquely identifies the switch 
within the fabric, and the name of the switch.
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Active Paths: This line is followed by information about each 
destination domain, including information about 
each of the paths between that domain and the 
local domain.

Destination 
Domain ID:

The ID of the destination domain that is 
described in the lines following the ID. This 
information and the two lines following it 
display for each destination domain in the fabric.

Destination’s 
Worldwide Name:

The WWN of the destination domain.

Number of Paths: The number of active paths between the 
destination domain and the local domain.

Path Number: The number assigned to the specific path 
described in the table that follows this 
information. This information and the following 
table display for each path for which the domain 
described above is the destination.

Output Ports The number of output ports on the path between 
the destination domain and the local domain.

Input Ports The number of input ports on the path between 
the destination domain and the local domain.

Hop Count The number of hops (interswitch links) between 
the local domain and the destination domain.

Metric Metrics for traffic flow along the path.

Flag The flag assigned to the path.
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Name Server Table View
The Name Server Table View provides the name server entries listed in the 
Simple Name Server database. This includes all name server entries for the 
fabric, not only those that are local to the local domain. Each row in the 
table represents a different device.

To access Name Server Table View:

1. Launch a web browser.

2. Enter the switch name or IP address in the Location/Address field and 
press Enter. For example: http://switchname/.

Web Tools launches, displaying Fabric View.

3. Click Name Server

Note To sort the events by a particular column, click the column 
header. To resize a column, drag the column divider.

Figure 6. Name Server Table View
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The following fields are included in the Name Server Table View:

The Name Server Table also includes the following columns:

Auto Refresh Check to enable Auto Refresh or uncheck to disable.

Auto Refresh 
Interval

If Auto Refresh is checked, enter the number of 
seconds for the refresh interval.

Refresh Click to refresh the window immediately.

Done Click to close the window.

Domain # The domain ID of the switch to which the device is 
connected.

Port # The number of the switch port to which the device is 
connected.

Port ID The port ID of the device (24-bit hexadecimal value).

Port Type The port type of the device (N for fabric direct attached 
port or NL for fabric direct attached loop port).

Port WWN The worldwide name of the device port.

Node WWN The worldwide name of the device node.

Symbolic Name The symbolic name of the device assigned through the 
SCSI INQUIRY command.

FC4 Types The fibre channel FC4 layer types supported by the 
device, such as IP or FCP.

COS The fibre channel classes of service supported by the 
device.

Fabric Port Name The name of the fabric port in use by the device.

Port IP Address The IP address of the fabric port.

Hard Address The hard address of the fabric port.

Member of Zones The zones to which this device belongs. This column 
does not update when the table is refreshed. To view 
updated zoning information, close and reopen the 
Name Server Table.
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Zone Administration View
Administrative privileges are required to access this view. If a switch or 
device is added or removed from the network, it is necessary to save the 
changes and relaunch the Zone Administration view for the changes to take 
effect.

When administering Zoning, the following steps are recommended:

1. Define zone aliases to establish groupings. 

2. Add zone members. 

3. Place zones into one or more zone configurations.

4. Enable one of the zone configurations (only one can be enabled at a time).

There are three separate methods for adding members to a zone. Each 
method corresponds to a zoning “mode,” and the combination of the 
methods corresponds to an additional mode. Once a mode is selected, all 
zoning operations must correspond to that mode, and any zones, aliases, 
and configuration files which do not cannot be selected.

Port Level Zoning Zoning by physical domain/port number. All alias, 
zoning, and configuration file operations must be 
performed using port. Aliases, zones, and 
configuration files which have objects other than 
ports cannot be selected or operated on.

WWN Level 
Zoning

Zoning by WWNs only. All alias, zoning, and 
configuration file operations must be performed by 
WWNs. Aliases, zones, and configuration files 
which have objects other than WWNs cannot be 
selected or operated on.

Device Level 
Zoning

Zoning by Quick Loop device. All alias, zoning, and 
configuration file operations must be on AL_PAs in a 
QuickLoop. Aliases, zones, and configuration files 
which have objects other than AL_PAs in a 
QuickLoop cannot be selected or operated on.
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For more information about using Zoning, see the Zoning User’s Guide.

To access the Zone Administration View:

1. Launch a web browser.

2. Enter the switch name or IP address in the Location/Address field and 
press Enter. For example: http://switchname/. This switch is assumed to 
be the local domain.

Web Tools launches, displaying Fabric View.

3. Click Zone Admin.

The Zone Administration View displays (see Figure 7).

Note For information specific to QuickLoop to be available, the 
QuickLoop switch must be the local domain.

Following is a list of the tabs provided in the Zone Admin View, and the 
pages on which they are described:

• “Alias Tab” on page 38

• “Zone Tab” on page 40

• “QuickLoop Tab” on page 42

• “Config Tab” on page 44

Mixed Level 
Zoning

Zoning by physical domain/port number, WWN, or 
AL_PA. With mixed level zoning, any object can be 
selected to be a member of a zone, alias, or 
configuration file. This mode is supported for 
backward compatibility with previous switches.
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Alias Tab
You can use the Alias tab to create and manage aliases for devices in the 
fabric. An alias can have one or more members, including switches, ports, 
WWNs, and QuickLoop AL_PAs.

Following is a description of the fields on the Alias tab:

Figure 7.  Alias Tab in the Zone Administration View

Alias Name To modify an existing alias, select an alias name.

Create Alias Click to create a new alias. A dialog box appears in 
which you can enter the name of the new alias. All 
names must be unique and contain no spaces.
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Delete Alias Click to delete the alias selected in the Alias Name 
field. Deleting an alias automatically removes it from 
all zones.

Rename Alias Click to rename the alias selected in the Alias Name 
field. A dialog box appears in which you can edit the 
alias name. Renaming an alias automatically renames 
it in all zones.

Member Selection 
List

A list of potential alias members, including switches, 
ports, WWNs, and QuickLoop AL_PAs.

Add Member Click to add the item selected in the Member 
Selection List to the Alias Members list. You can add 
individual ports or an entire switch. If a switch is 
added, all ports on the switch are added. To add a 
device WWN, select either a node WWN (folder 
icon) or port WWN (blue circle icon) from the WWN 
sub-tree.

Remove Member Click to remove the selected member selected from 
the [Alias name] Members list.

Add Other Click to add a WWN, switch port, or QuickLoop 
AL_PA that is not available in the Member Selection 
List.

Alias Members The member list of the alias selected in the Alias 
Name field. The name of this list depends on the 
name of the selected alias. If no alias is selected, the 
name displays as “null Members”.

Apply Click to apply all changes made since the Zone 
Administration View was opened, including changes 
made on other tabs in the view. Changes cannot be 
cancelled once applied.
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Zone Tab
You can use the Zone tab to create and manage zones. A zone can have one 
or multiple members, and can include switches, ports, WWNs, aliases, and 
QuickLoop AL_PAs.

Cancel Click to cancel all changes made since changes were 
last applied, and to exit the Zone Administration 
View. Changes cannot be cancelled once they are 
applied.

Done Click to apply all changes made since the Zone 
Administration View was opened and to exit the Zone 
Administration View.

Figure 8.  Zone Tab in the Zone Administration View
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Following is a description of the fields on the Zone tab:

Zone Name To modify an existing zone, select a zone name.

Create Zone Click to create a new zone. A dialog box appears in 
which you can enter the name of the new zone. All names 
must be unique and contain no spaces.

Delete Zone Click to delete the zone selected in the Zone Name field. 
Deleting a zone automatically removes it from all zone 
configurations.

Rename Zone Click to edit the name of the zone selected in the Zone 
Name field. A dialog box appears in which you can edit 
the name of the zone.

Member 
Selection List

A list of potential zone members, including switches, 
ports, WWNs, aliases, and QuickLoop AL_PAs.

Add Member Click to add the member selected in the Member 
Selection List to the Zone Members list. If an entire 
switch is selected, all ports on the switch are added to the 
zone. You can also select individual ports. To add a 
device WWN, select either a node WWN (folder icon) or 
port WWN (blue circle icon) from the WWNs sub-tree. 
To add an alias to the zone, select it from the Aliases 
sub-tree (the alias must already exist).

Remove 
Member

Click to remove the selected member from the [Zone 
name] Members list.

Add Other Click to add a WWN, switch, port, or QuickLoop AL_PA 
that is not listed in the Member Selection List.

[Zone name] 
Members

The members of the zone selected in the Zone Name 
field. The name of this list depends on the name of the 
selected zone. If no zone is selected, the name displays as 
“null Members”.

Apply Click to apply all changes made since the Zone 
Administration View was opened, including changes 
made on other tabs in the view. Changes cannot be 
cancelled once they are applied.
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QuickLoop Tab
You can use the QuickLoop tab to create and manage QuickLoops if used 
in conjunction with Zoning. For information on managing the QuickLoop 
feature separately, see “Loop Tab” on page 61.

Cancel Click to cancel all changes since the changes were last 
applied and to exit Zone Administration. Changes cannot 
be cancelled once they are applied.

Done Click to apply all changes made since the Zone 
Administration View was opened and to exit the Zone 
Administration View. 

Figure 9. QuickLoop Tab in the Zone Administration View
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Following is a description of the fields on the QuickLoop tab:

QuickLoop Name To modify an existing QuickLoop, select a 
QuickLoop name.

Create Qloop Click to create a new QuickLoop. A dialog box 
appears in which you can enter the name of the new 
QuickLoop. All names must be unique and contain no 
spaces.

Delete Qloop Click to delete the QuickLoop selected in the 
QuickLoop Name field. Deleting a QuickLoop 
automatically removes it from all aliases, zones, and 
zone configurations, including the associated 
AL_PAs.

Rename Qloop Click to edit the name of the QuickLoop selected in 
the QuickLoop Name field. A dialog box appears in 
which you can edit the name of the QuickLoop.

Switch Selection 
List

A list of the switches available to add to the 
QuickLoop.

Add Member Click to add the switch selected in the Switch 
Selection List to the QuickLoop Members list.

Remove Member Click to remove the selected member from the 
[QuickLoop name] Members list.

[QuickLoop name] 
Members

A list of the members of the QuickLoop currently 
selected in the QuickLoop Name field. The name of 
this list depends on the name of the selected 
QuickLoop. If no QuickLoop is selected, the name 
displays as “null Members”.

Apply Click to apply all changes made since the Zone 
Administration View was opened, including changes 
made on other tabs in the view. Changes cannot be 
cancelled once they are applied.
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Config Tab
You can use the Config tab to create and manage zone configurations. Zone 
configurations allow you to enable or disable a group of zones at the same 
time.

Cancel Click to cancel all changes since the changes were 
last applied and to exit Zone Administration. Changes 
cannot be cancelled once they are applied.

Done Click to apply all changes made since the Zone 
Administration View was opened and to exit the Zone 
Administration View.

Figure 10. Config Tab in the Zone Administration View
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Following is a description of the fields on the Config tab:

Config Name To modify an existing configuration, select a 
configuration name.

Create Cfg Click to create a new configuration. A dialog box 
appears in which you can enter the name of the new 
configuration. All names must be unique and contain no 
spaces.

Delete Cfg Click to delete the configuration selected in the Config 
Name field.

Rename Cfg Click to edit the name of the configuration selected in 
the Config Name field.

Zone/QLoop 
Selection List

A list of the zones and QuickLoops available to add to 
the configuration.

Add Member Click to add the switch selected in the Zone/QLoop 
Selection List to the Configuration Members list.

Remove Member Click to remove the selected member from the 
[Configuration name] Members list.

[Configuration 
name] Members

The members of the configuration selected in the Config 
Name field. The name of this list depends on the 
selection. Only one configuration can be enabled at a 
time; if none are enabled, zoning is not active in the 
fabric.

Enable Config Check to enable the configuration selected in the Config 
Name field, or uncheck to disable it.

Config to enable Displays the name of the configuration that is currently 
selected for enabling. This configuration can be enabled 
by clicking Apply.

Config currently 
enabled

Displays the name of the currently enabled 
configuration. Only one configuration can be enabled at 
a time.

Apply Click to apply all changes made since the Zone 
Administration View was opened, including changes 
made on other tabs in the view. Changes cannot be 
cancelled once they are applied.
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Switch View
The Switch View represents the front panel of the switch, and displays 
when you click a Switch icon in Fabric View. This view provides 
information about the overall status of the switch and the status of the 
individual elements in the switch. The information displayed is as close as 
possible to a real-time view of switch status. If the switch is not functioning 
properly, a message explains the problem detected. 

Note Switch status is stored as the variable “switchStatus”, and is 
calculated approximately once per second; however, the initial calculation 
does not occur until 30–60 seconds after the switch is booted.

To access Switch View:

1. Launch a web browser.

2. Enter the switch name or IP address in the Location/Address field and 
press Enter. For example: http://switchname/.

Web Tools launches, displaying Fabric View.

Cancel Click to cancel all changes since they were last applied 
and to exit the Zone Administration View. Changes 
cannot be cancelled once applied.

Done Click to apply all changes made since the Zone 
Administration View was opened and to exit the Zone 
Administration View.
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3. Click the Switch icon.

Following is a description of the items and information available in Switch 
View: 

Figure 11. Switch View

Port icons The letters in the Port icon indicate the Gigabit Interface 
Converter (GBIC) type, as follows:

• blank No GBIC present

• SW Short wave GBIC

• LW Long wave GBIC

• SWID Short wave serial ID GBIC

• LWID Long wave serial ID GBIC

A yellow outline around a port icon indicates port failure. 
For detailed port information, click the Port icon to see the 
Port Information View.

Port numbers 
(on the right 
of each port)

The number of the port.
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LED Status 
Indicators 
(round light 
next to each 
port)

The color indicates the status of the port.

• No light No device attached

• Steady yellow Receiving light, but not
online; check cable
connections

• Slowly flashing yellow Disabled (diagnostics or
portDisable command)

LED Status 
Indicators 
(round light 
next to each 
port)

• Rapidly flashing yellow Error, fault with port

• Steady green Online (connected with
device by cable)

• Slowly flashing green Online but segmented
(loopback cable or
incompatible switch)

• Rapidly flashing green Internal loopback (diagnostic)

• Flickering green Online and
transmitting/receiving frames

Power supply Removable power assemblies are updated to show 
presence/absence and status of each:

• Green Power supply present and operational

• Red X Power supply present but not
operational

• Cover plate Power supply absent or not fully
plugged in

Events Click to access Switch Events View.
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Telnet Click to launch a Telnet session.

Fabric Watch 
(optional 
software)

Click to access Fabric Watch.

Fan The background color of the button indicates the overall 
status of the fans: 

• Green Healthy

• Yellow Marginal (mix of good and faulty readings)

• Red Down (more than two faulty readings)

• Gray Unknown or unmonitored

Admin Click to display the Administrative Interface where you 
can perform switch management functions.

Perf Click to display the Performance View where you can 
monitor switch performance.

Beacon Click to turn on the beaconing function. If on, this icon 
shows beams of light. The beaconing function helps to 
physically locate a switch by sending a signal to the 
specified switch, resulting in an LED light pattern flashing 
from side to side on the switch.
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Temp Click to display temperature readings from all switch 
thermo sensors. The background color of the button 
indicates the overall temperature status: 

• Green Healthy

• Yellow Marginal (mix of good and faulty readings)

• Red Down (more than two faulty readings)

• Gray Unknown or unmonitored

WWN Unique numeric identifier for each switch; assigned by 
manufacturer.

Domain ID Number that uniquely identifies the switch in a fabric.

Role Indicates the current role of the switch.

• Principal The principal switch as defined by
FC_SW protocol.

• Subordinate Enabled but not the principal switch.

• Disabled Disabled.

State Indicates the current state of the switch, which may be 
online, offline, testing, or faulty.

Firmware Fabric OS version.

Serial # The serial number of the switch being viewed.

Ether IP Ethernet IP address.

Ether NM Ethernet netmask value.

FC IP Fibre channel IP address.

FC NM Fibre channel netmask value.

Gateway IP address of default gateway. Must be properly set to 
access switch from other networks.
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Switch Events View
The Switch Events View displays a running log of events for the selected 
switch. 

To access Switch Events View:

1. Launch a web browser.

2. Enter the switch name or IP address in the Location/Address field and 
press Enter. For example: http://switchname/.

Web Tools launches, displaying Fabric View.

3. Click the Switch icon.

The Switch View displays.

4. Click the Events icon.

Note To sort the events by a particular column, click the column 
header. To resize a column, drag the column divider.

Figure 12. Switch Events View
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Following is a description of the columns in Switch Events View:

Port Information View
The Port Information View displays statistics for the selected port. This 
information is automatically updated when the view is opened, and is also 
refreshed periodically while the view remains open.

To access Port Information View:

1. Launch a web browser.

2. Enter the switch name or IP address in the Location/Address field and 
press Enter. For example: http://switchname/.

Web Tools launches, displaying Fabric View.

3. Click the Switch icon in Fabric View. 

The Switch View displays.

Switch Name of switch.

Num... Event number.

Time Time of event.

Count Number of back-to-back occurrences of same event.

Level Severity level of event:
0 panic (switch reboots)
1 critical
2 error
3 warning
4 information
5 debug

Message Description of event.
52 Web Tools User’s Guide



4. Click a Port icon.

The following tabs are available in Port Information View, and are 
described on the pages listed:

• “PortStats Tab” on page 56

• “GBIC Tab” on page 58

• “Loop Tab” on page 61

Figure 13. Port Information View
Using Web Tools 53



Following is a description of the fields that are visible in Port Information 
View regardless of which tab is selected: 

Port WWN Worldwide name (WWN) of this port.

Port Module The GBIC type, as follows:

• -- No GBIC present

• SW Short wave GBIC

• LW Long wave GBIC

• SWID Short wave serial ID GBIC

• LWID Long wave serial ID GBIC

Port Status The current status of the port.

• No_Module No GBIC module is in this
port.

• No_Light Module is not receiving
light.

• No_Sync Module is receiving light
but out of sync.

• In_Sync Module is receiving light
and in sync.

• Laser_Flt Module signaling a laser
fault (defective GBIC).
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Port Status • TPort_Flt Port is marked faulty
(defective GBIC, cable,
or device).

• Diag_Flt Port failed diagnostics.

• Online Port is up and running.

• Lock_Ref Port is locking to reference
signal.

Note Removing a cable from an E_Port 
temporarily generates errors, causing the 
status to show as faulty. The status returns to 
healthy when the sample interval has passed 
(the default interval is 1 minute).

Port Type The type of port.

• E_Port Switch link port

• G_Port Generic port

• U_Port Universal port

• F_Port Fabric port

• FL_Port Fabric loop port

• L_Port Loop port
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PortStats Tab
The PortStats tab provides information about transmission speed, reception 
speed, and the volume of traffic through the selected port.

Following is a description of the fields on the PortStats tab:

Figure 14. PortStats Tab in the Port Information View

4-Byte Word Transmitted Number of four-byte words transmitted.

4-Byte Word Received Number of four-byte words received.

Frames Transmitted Number of frames transmitted.

Frames Received Number of frames received.

C2 Frames Received Number of class 2 frames received.

C3 Frames Received Number of class 3 frames received.

Link Control Frames 
Received

Number of link control frames received.

Mcast Frames Received Number of multicast frames received.

Mcast Time-outs Number of multicast timeouts.
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Mcast Frames Transmitted Number of multicast frames transmitted.

Time R_RDY Priority Number of times R_RDY has priority over 
frames to be sent.

Time BB_Credit Zero Number of times BB_Credit went to zero.

Encd Errs Inside Frames Number of encoding errors inside frames.

Frames with CRC Errs Number of frames with CRC errors.

Short Frames Number of frames shorter than minimum.

Long Frames Number of frames longer than maximum.

Bad End-of-Frames Number of frames with faulty 
end-of-frames.

Encd Errs Outside Frames Number of frames with encoding errors 
outside frames.

C3 Frames Discarded Number of class 3 frames discarded.

LIP Ins Number of LIPs received.

LIP Outs Number of times loop initialized by 
FL_Port.

Last LIP Received Last LIP received:  AL_PD, AL_PS.

Frames Rejected Number of F_RJTs sent.

Frames Busied Number of F_BSYs sent.

Link Failure Number of times NOS received/sent.

Loss of Sync Number of times loss of sync occurred.

Loss of Signal Number of times loss of signal occurred.
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GBIC Tab
The GBIC tab provides information about the GBIC installed in the 
selected port. The information displayed depends on the type of GBIC 
installed:

• Standard GBIC Module type (short wave, long wave, etc.).

• Serial ID GBIC Module type, plus extended information about
capabilities, interfaces, and manufacturer.

• Smart Finisar GBIC All of the above information, plus GBIC active
status.

If the port does not contain a GBIC, the following information displays: 
“Not a serial ID GBIC. No GBIC info available.”

Figure 15. GBIC Tab in the Port Information View
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Following is a description of the fields on the GBIC tab:

Identifier Indicates the type of serial transceiver, which can be 
GBIC or on-board.

Connector Indicates the external connector type, which can be one 
of the following:

• SC

• BNC/TNC

• Coaxial

ID Name Indicates the GBIC module type:

• -- No GBIC present

• sw Short wave GBIC

• lw Long wave GBIC

• swid Short wave serial ID GBIC

• lwid Short wave serial ID GBIC

• cuid Short wave serial ID GBIC

GBIC Speed Indicates the GBIC speed, which can be 100, 200, or 400 
MBps.

GBIC Media Indicates the transmission media, which can be: 

• SM Single mode

• M5 Multi-mode, 50u

• M6 Multi-mode, 62.5u

• TV Video coax

• MI Miniature coax

• TP Shielded twisted pair

• TW Twin axial pair

GBIC Distance Indicates the length of the fibre channel link, which can 
be long distance, intermediate distance, or short distance.
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Encoding Indicates the serial encoding mechanism, which can be 
8B10B, 4B5B, NRZ, or Manchester.

Baud Rate Nominal baud rate in units of 100 Megabyte.

BR Max Upper limit at which GBIC meets its specifications (in 
units of 1 percent above nominal baud rate).

BR Min Lower limit at which GBIC meets its specifications (in 
units of 1 percent below nominal baud rate).

Options May indicate any of the following:

• Loss of Signal

• Loss of Signal Inverted

• Transmission Fault

• Transmission Disable

Length 9u Length of link using single mode fibre.

Length 50u Length of link using 50um multi-mode fibre.

Length 625u Length of link using 62.5um multi-mode fibre.

Vendor Name Name of vendor.

Vendor OUI Unique identifier for vendor.

Vendor P/N Vendor part number.

Vendor Rev Vendor revision number.

Serial No. Vendor serial number.

Date Code Vendor date code.

Smart GBIC Data (only displays if a smart GBIC is present):

Temperature Module temperature (in Centigrade).

Rx Power Received optical power in micro Watts.

Tx Power Transmitted optical power in micro Watts (longwave 
only).

Current Laser diode drive current in mAmps.
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Loop Tab
The Loop tab provides information about any loop on the port, including 
the following:

• Loop statistics

• Local AL_PA statistics

• QuickLoop looplet statistics (if the port is a member of the QuickLoop)

• QuickLoop statistics (if the port is a member of the QuickLoop)

If the port is not a loop-enabled port, the following information displays: 
“Not an L_Port. No loop info available.”

Following is a description of the fields on the Loop tab:

Figure 16. Loop Tab in the Port Information View

FL Port Transfer Displays number of times FL_Port used 
transfer state.

FL Tenancies Displays the number of times FL_Port opens 
loop tenancy.
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NL Tenancies Displays the number of times NL_Port opens 
loop tenancy.

Number of QL/Zone Inits 
Caused

Displays number of times looplet has caused 
QuickLoop to be initialized.

Number of Successful 
QL/Zones Inits

Displays number of times looplet has 
successfully initialized.

Number of Failed 
QL/Zone Inits

Displays number of times looplet failed to 
successfully initialize.

Number of Times Being 
Bypassed

Displays number of times looplet was not 
included as part of QuickLoop.

Last Time bypassed Displays time that looplet was last bypassed.

Local AL_PA List Displays list of AL_PAs associated with 
devices connected to loop.

Number of QL Init 
Attempts

Displays number of times QuickLoop 
attempted initialization.

Number of Successful 
QL Inits

Displays number of time QuickLoop 
successfully initialized.

Number of Times in 
Single Switch Mode

Displays number of times switch reverted to 
single switch mode.

Number of Times in Dual 
Switch Mode

Displays number of times switch operated in 
dual switch mode.

Time of Last QL Init Displays time of latest QuickLoop 
initialization.

Switch, Port Caused the 
Last Init

Displays number of switch, port that caused the 
latest initialization.

Diag Click to open the Loop Diagnostics dialog box, 
which allows you to run loop diagnostics 
(requires password). For more information, see 
“Loop Diagnostics Dialog Box” on page 63.
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Loop Diagnostics Dialog Box
This dialog appears when you click DIAG on the Loop tab of the Port 
Information View. You can use the Loop Diagnostics option to identify 
faulty devices on a loop.

LIP Click to open the LIP dialog box, which allows 
you to initialize the loop (requires password). 
For more information, see “LIP Dialog Box” on 
page 64.

Bypass Click to open the Bypass dialog box, which 
allows you to bypass a specified looplet 
(requires password). For more information, see 
“Bypass Dialog Box” on page 64.

Enable Click to open the Enable dialog box, which 
allows you to enable an AL_PA on a specified 
looplet (requires password). For more 
information, see “Enable Dialog Box” on 
page 65.

Figure 17. Loop Diagnostics Dialog Box
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Following is a description of the fields in the Loop Diagnostics dialog box:

LIP Dialog Box
You can use the LIP (Loop Initialization Process) option to initialize a loop 
port. To access this option, click LIP on the Loop tab of the Port 
Information View.

Following is a description of the fields in the LIP dialog box:

Bypass Dialog Box
You can use the Bypass option to bypass an AL_PA (a device) on the loop 
port. To access this option, click Bypass on the Loop tab of the Port 
Information View.

Start Click to start the Loop Diagnostics on the specified 
port.

Stop Click to stop (abort) Loop Diagnostics on the 
specified port.

Close Click to close the Loop Diagnostics function.

Figure 18. LIP Dialog Box

Apply Click to initialize a loop port.

Close Click to close the LIP dialog box.

Figure 19. Bypass Dialog Box
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Following is a description of the fields in the Bypass dialog box:

Enable Dialog Box
You can use the Enable option to enable an AL_PA on the loop port that 
was previously bypassed. To access this option, click Enable on the Loop 
tab of the Port Information View.

Following is a description of the fields in the Enable dialog box:

AL_PA to Bypass Specify the AL_PA number to bypass.

Do not bypass the last AL_PA on the loop, as this will 
put it into a loopback state, requiring a reboot to 
return it to an L-Port state.

Apply Click to bypass an AL_PA on the loop port (must be a 
valid AL_PA).

Close Click to close the Bypass dialog box.

Figure 20. Enable Dialog Box

AL_PA to Enable Specify AL_PA to be enabled. Entering oxff will 
enable all the AL_PAs in the loop.

Apply Click to enable the AL_PA (must be valid AL_PA).

Close Click to close Enable an AL_PA window.
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Fabric Watch View (Optional Software)
You can use Fabric Watch View to monitor fabric elements for potential 
problem conditions. For detailed information about Fabric Watch, see the 
Fabric Watch User’s Guide.

To access Fabric Watch View:

1. Launch a web browser.

2. Enter the switch name or IP address in the Location/Address field and 
press Enter. For example: http://switchname/.

Web Tools launches, displaying Fabric View.

3. Click the Switch icon.

The Switch View displays.

4. Click the Watch icon.

The Fabric Watch View displays, with the Alarm Notifications tab 
(described in the following section) selected by default. 

Fabric Watch View contains the following tabs:

• Alarm Notifications

• Configure Thresholds

• Current Settings

In addition, an organizational tree appears on the left, showing all the 
Fabric Watch areas regardless of which tab is selected. To expand or 
contract a folder in the tree, double-click the folder.

Alarm Notifications Tab
You can use the Alarm Notifications tab to view and customize the Fabric 
Watch notifications. You can either accept the default notifications or select 
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the Custom option and specify the type of notification (Syslog, 
SNMP_Trap, or Port log lock) for each type of event.

Figure 21. Alarm Notifications Tab in the Fabric Watch View
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Configure Thresholds
You can use the Configure Thresholds tab to view and configure Fabric 
Watch thresholds for the Fabric Watch class currently selected in the 
organizational tree on the left side of the window.

Figure 22. Configure Threshold Tab with the Environment Class Selected in the 
Fabric Watch View
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The Configure Threshold display changes according to the class and area 
selected in the organizational tree. However, the Configure Thresholds tab 
always contains the following buttons:

Thresholds for the Environmental and GBIC Classes
The Environmental and GBIC classes both display a separate column for 
each area (see Figure 22). 

Default Click to return settings to default values.

Apply Click to apply the values specified in the current 
display. When Apply is clicked after a change, 
the following dialog displays:

Figure 23. Alarm Mechanism Dialog Box

To continue, select the type of alarm you want 
and click Apply. 

Reset Click to undo the last changes that were applied.

The columns for the Temperature, Fan, RX Power, and TX Power areas 
contain the following items:

Threshold Type 
drop-down list

Select the threshold type (outranged, above, 
in-between, below, changed).

High/Low         
drop-down list

Select to enter the high and low settings for the 
threshold type selected in the Threshold Type 
drop-down list (not available for all areas).

Scale Specify the point at which you want to set the 
specified threshold.

Area drop-down list Select a Fabric Watch area.
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Thresholds for the Remaining Classes
The Port, E_Port, and F/FL Optical Port classes display the following fields 
for each area (Link Loss, Sync Loss, Signal Loss, Protol Error, Invalid 
Words, Invalid CRCs, State Changes, RX Performance, TX Performance):

Watched checkbox Check or uncheck to specify whether you want this 
area watched (not available for all areas).

The columns for the Power Supply and Current areas contain the 
following item:

“Send alarms 
when” box

Use this text box to specify whether you want to be 
notified when the area is in the acceptable range 
(OK) or is faulty (FAULTY). 

Low text box Enter the lowest number of occurrences that are 
acceptable.

High text box Enter the highest number of occurrences that are 
acceptable.

Threshold Type 
drop-down list

Select the type of threshold.

Time period 
drop-down list

Select the time period you want applied to frequency 
measurements.
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The thresholds for the Port class are displayed in the following figure:

Figure 24. Configure Threshold Tab with the Port Class Selected in Fabric Watch 
View
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Current Settings Tab 

The Current Settings tab allows you to view the current Fabric Watch 
threshold parameters for the area selected in the Fabric Watch tree.

Performance View
The Performance View graphically displays throughput (megabytes per 
second) for each port and also for the entire switch. “Port throughput” is the 
number of bytes received at a port plus the number of bytes transmitted. 
“Switch throughput” is the sum of the throughput for all the ports.

To access Performance View:

1. Launch a web browser.

2. Enter the switch name or IP address in the Location/Address field and 
press Enter. For example: http://switchname/.

Web Tools launches, displaying Fabric View.

Figure 25. Current Settings Tab in the Fabric Watch View
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3. Click the Switch icon.

The Switch View displays.

4. Click the Performance icon.

In addition to the port graphs, a graph for the entire switch is provided at 
the bottom of the window. Resizing the window changes the size and shape 
of all the individual graphs.

In both the port and switch graphs, the horizontal axis represents elapsed 
time and the vertical axis represents throughput. Each port graph contains 
up to 60 seconds of performance data, and the switch graph at the bottom of 
the view can contain up to four minutes of data.

Figure 26. Performance View
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Administrative Interface
The Administrative Interface provides access to the administrative 
functions though the following tabs:

• “Switch Admin Tab” on page 76

• “User Admin Tab” on page 78

• “Firmware Upgrade Tab” on page 80

• “Reboot Switch Tab” on page 81

• “SNMP Admin Tab” on page 82

• “License Admin Tab” on page 84

• “Remote Switch Tab (Optional Software)” on page 85

• “QuickLoop Admin Tab (Optional Software)” on page 86

• “Config Admin Tab” on page 89

• “Extended Fabric Tab (Optional Software)” on page 91

Note The Administrative Interface requires administrative privileges. 
Once an administrative login is entered, administrative privileges remain 
available until the web browser is exited.

To access the Administrative Interface:

1. Launch a web browser.

2. Enter the switch name or IP address in the Location/Address field and 
press Enter. For example: http://switchname/.

Web Tools launches, displaying Fabric View.
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3. Click the Admin icon on the switch panel.

4. Enter your user name and password. The logon account must have 
administrative privileges.

5. Click OK.

The Administrative Interface displays, with the Switch Admin tab 
selected by default.

Figure 27. The Enter Network Password Dialog
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Switch Admin Tab
You can use the Switch Admin tab to change IP information, enable/disable 
a switch, change the domain, change the switch name, see which ports are 
enabled, and enable/disable individual ports.

Figure 28. Switch Admin Tab
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Following is a description of the fields on the Switch Admin tab:

Switch Name Displays or sets the switch name. To change the name, 
enter new name in this field.

Domain ID Displays or sets the switch domain ID. Domain IDs 
must be unique within a fabric. 

To change the domain ID, enter a new domain ID in 
this field. Use a number from 1 to 239 for normal 
operating mode (FCSW compatible) and a number 
from 0 to 31 for VC encoded address format mode.

Extended Fabric Check to allow ports to be configured for long distance, 
or uncheck to turn the option off.

Switch Disabled Check to disable the switch, or uncheck to enable the 
switch.

Ethernet IP Displays or sets the IP address for Ethernet connection 
to switch. 

Ethernet 
Subnetmask

Displays or sets Ethernet subnetmask. Default value is 
none. Contact the network administrator for the value 
to enter. If changed, restart the browser.

Fibre Channel IP Displays or sets the fibre channel IP address.

Fibre Channel 
Subnetmask

Displays or sets the fibre channel subnetmask. If 
changed, restart the browser.

Gateway IP Displays or sets the gateway IP address. Contact the 
network administrator for the IP address. If changed, 
restart the browser.

Syslog Daemon IP Displays or sets the destination station IP address for 
sending events using syslog protocol to host. Contact 
the network administrator for the IP address. If 
messages are not to be sent, enter none or leave blank. 
Maximum of six IP addresses. Enter multiple addresses 
as a list, for example 192.16864.35, 192.16862.36, etc. 

Port No Port number.
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User Admin Tab
You can use the User Admin tab to rename accounts or change passwords.

Port Disabled If the box is checked, the port is disabled. To enable the 
port, uncheck the box.

Commit 
Configuration 
Changes

Click to apply changes made.

Reset Click to reset all fields to values present when Switch 
Administration was launched.

Figure 29. User Admin Tab
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Following is a description of the fields on the User Admin tab:

Access Level Access level required – Admin or User.

Change User Name 
To

Enter new user name.

Change Password 
To

Enter new password.

Verify Password Re-enter password to verify.

Commit User 
Name/Password 
Changes

Click to apply changes made.

Reset Click to reset all fields to values set at last 
submission.
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Firmware Upgrade Tab
You can use the Firmware Upgrade tab to download firmware upgrades.

Following is a description of the fields on the Firmware Upgrade tab:

Figure 30. Firmware Upgrade Tab

Host Name or Host IP Displays or sets host name or host IP 
address.

Remote User Name Displays or sets remote user name.

Download File From Enter path name for firmware download.

Select Protocol Select the protocol for the download.
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Reboot Switch Tab
You can use the Reboot Switch tab to reboot or fast boot the switch or to 
disable Power On Self Test (POST) for future reboots.

Password Required for FTP Enter a password if FTP was selected as the 
protocol.

Download Firmware Click to download firmware.

Reset Click to reset all fields to values present 
when Firmware Upgrade was launched.

Figure 31. Reboot Switch Tab
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Following is a description of the fields on the Reboot Switch tab:

SNMP Admin Tab
You can use the SNMP Admin tab to set SNMP options.

Disable POST Check to disable POST for future reboots, or uncheck 
to enable POST.

Commit Change Click to save settings.

Reboot Switch Click to reboot the switch.

Fastboot Switch Click to perform a fast reboot. A fastboot bypasses 
POST. (It is the same as a reboot with POST disabled.)

Figure 32. SNMP Admin Tab
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Following is a description of the fields on the SNMP Admin tab:

System Description Displays or sets system description. Default is Fibre 
Channel Switch.

System Location Displays or sets location of switch. Default is End 
User Premise.

System Contact Displays or sets contact information for switch. 
Default is Field Support.

Event Trap Level Sets severity level of switch events that prompt 
SNMP traps. Default is 0.

Enable 
Authentication 
Traps

Click on to enable authentication traps; click off to 
disable (recommended).

Read Write 
Community String

Displays or sets up to three strings that work with the 
SNMP set command.

Read Only 
Community String

Displays or sets up to three strings that work with the 
SNMP get or get-next command.

Read Write and 
Read Only Trap 
Recipients

Displays or sets recipients for traps (usually IP 
address of SNMP management station).

Commit SNMP 
Changes

Click to apply changes made.

Reset Click to reset all fields to values present when SNMP 
Administration was launched.

To disable the community string or trap recipient fields, leave them empty.
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License Admin Tab
You can use the License Admin tab to view a list of installed license keys 
and features or to add or remove licenses.

Following is a description of the fields on the License Admin tab:

Figure 33. License Admin Tab

License Key Enter license key to be added or removed.

Add License Click to add specified license.

Remove License Click to remove specified license.

Text box A list of the licenses installed on the switch.
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Remote Switch Tab (Optional Software)
You can use the Remote Switch feature to configure a pair of switches to 
operate over an extended WAN interface so that they can communicate 
across an ATM network by using a compatible Fibre Channel to ATM 
gateway. For detailed information on the Remote Switch feature, see the 
Distributed Fabrics User’s Guide.

You can use the Remote Switch tab to enable or disable the Remote Switch 
feature on the selected switch.

Figure 34. Remote Switch Tab
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Following is a description of the fields on the Remote Switch tab:

QuickLoop Admin Tab (Optional Software)
You can use the QuickLoop Admin tab to manage QuickLoop features. For 
information about managing the features available when QuickLoop and 
Zoning are used together, see “Zone Administration View” on page 36. For 
detailed information about the QuickLoop feature, see the QuickLoop 
User’s Guide.

Remote Switch Enabled Check to enable the Remote Switch feature, or 
uncheck to disable it.

Commit Remote 
Switch Change

Click to apply changes made.

Reset Click to reset all fields to values present when 
Remote Switch was launched.
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You can use the QuickLoop Admin tab to modify a QuickLoop or set up a 
partner switch.

Following is a description of the fields on the QuickLoop Admin tab:

Figure 35. QuickLoop Admin Tab

Enable Switch for 
QuickLoop Mode

Check to enable the switch for QuickLoop, or 
uncheck to disable the switch for QuickLoop.

Port No Port number.

QuickLoop Port 
Enabled

Check to enable the port for QuickLoop, or uncheck 
to disable the port for QuickLoop.
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QuickLoop Ports 
Bypassed

If checked, indicates a port is currently bypassed.

Current QuickLoop 
Partner

Displays the current partner switch WWN, domain 
ID, and switch name of a dual-switch QuickLoop.

Select a QuickLoop 
Partner for this 
Switch

Select a switch from the list of switch names 
currently in the fabric as the partner switch of a 
dual-switch QuickLoop.

Submit Click to apply changes made.

Reset Click to reset all fields to values present when 
QuickLoop Administration was launched.

AL_PA Bitmap (in 
hexadecimal)

Displays the AL_PA bitmap at the end of a 
QuickLoop initialization.

Local AL_PAs Lists the AL_PAs of devices connected to the local 
switch.

Remote AL_PAs Lists the AL_PAs of devices connected to the remote 
switch in a dual-switch QuickLoop. This information 
only displays if a partner is configured.
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Config Admin Tab
You can use the Config Admin tab to upload the switch configuration file 
for archiving, or to download a new configuration file from the host.

Figure 36. Config Admin Tab
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Following is a description of the fields on the Config Admin tab:

Switch Information Report
The Switch Information Report can be generated by clicking on the 
corresponding link on the Conf Admin tab in the Switch Admin window. It 
provides information about all the switches, interswitch links, and ports in 
the fabric

Host Name or Host 
IP

Specify the host name or host IP address.

Remote User 
Name

Specify the remote user name.

Configuration File 
Name

Specify the name of the configuration file to be 
uploaded or downloaded.

Select Protocol Specify FTP or RSHD protocols.

Password 
Required for FTP

Specify a password if one is required by the host.

Upload to Host Click to retrieve configuration file from the switch.

Download to 
Switch

Click to send configuration file to the switch.

Reset Click to reset all fields to values present when 
Configuration Administration was launched.

Switch 
Information 
Report

Click to open a browser window displaying a status 
report for the switch. Information can be printed or 
saved to file.
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Extended Fabric Tab (Optional Software)
The Extended Fabric feature allows you to configure ports for a long 
distance link of up to 100 km. For detailed information on this feature, see 
the Distributed Fabrics User’s Guide.

Figure 37. Switch Information Report
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You can use the Extended Fabric tab to specify which ports you want to be 
configured for distance and at what level.

Following is a description of the fields on the Extended Fabric tab:

Figure 38. Extended Fabric Tab

Port No Port Number.

Change Extended 
Fabric 
Configuration

Check to designate the ports for which you want to 
change the long distance configuration.
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Telnet Interface
Only one Telnet session can be active at a time.

Note The Telnet Interface requires administrative privileges. Once an 
administrative login is entered, administrative privileges remain available 
until the web browser is exited.

To access the Telnet Interface:

1. Launch a web browser.

2. Enter the switch name or IP address in the Location/Address field and 
press Enter. For example: http://Switchname/.

Web Tools launches, displaying Fabric View.

Configure selected 
port(s) to be long 
distance level

Select the long distance level to be supported for the 
selected ports. There are three levels:

• No long distance

• 50 km

• 100 km

Commit 
Configuration 
Changes

Click to apply configuration for Extended Fabrics.

Reset Click to reset all fields to values present when 
Extended Fabrics was launched.

Current Extended 
Fabric Settings

Displays current settings by port number.
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3. Click the Telnet icon on the switch panel.

If a Telnet session is already active, the following message displays:

4. If this message displays and you want to abort the active session, click 
Abort Session. Otherwise, click Cancel.

If there is no active session or it has been aborted, the following dialog 
appears:

5. Enter your user name and password (the account used must have 
administrative privileges).

6. Specify whether you want the password saved.

Figure 39. Telnet Session in Use Message

Figure 40. Enter Network Password Dialog Box
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7. Click OK.

Figure 41. Telnet Interface
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GLOSSARY

8b/10b   encoding Encoding scheme that converts each 8-bit data byte into a 10-bit transmission 
character. Used to balance ones and zeros in high speed transports.

Address identifier Value used to identify source or destination of a frame.

AL_PA Arbitrated Loop Physical Address. Unique 8-bit value assigned during loop 
initialization to each port in an arbitrated loop.

Alias Address 
Identifier

An address identifier recognized by a port in addition to its standard 
identifier. An alias address identifier may be shared by multiple ports.

Alias AL_PA An AL_PA value recognized by an L_Port in addition to the AL_PA assigned 
to the port. See also AL_PA.

Alias server Fabric software facility that supports multicast group management.

ANSI American National Standards Institute. Governing body for fibre channel 
standards in the U.S.A.

API Application Programming Interface. Defined protocol that allows 
applications to interface with a set of services.

Arbitrated loop A shared 100 MBps fibre channel transport structured as a loop. Allows 
communication between ports without using a switch. Requires successful 
arbitration by a port before a circuit is established. Supports up to 126 devices 
and one fabric attachment. Similar to a “shared bandwidth ring” on a network.

Arbitrating State The state in which a port has become the loop master. This state is only 
available from the Open state.

ASIC Application-Specific Integrated Circuit.
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ATM Asynchronous Transfer Mode. Transport for transmitting data over LANs or 
WANs that transmit fixed-length units of data. Provides any-to-any 
connectivity and allows nodes to transmit simultaneously.

AW_TOV Arbitration Wait Timeout Value. The minimum time an arbitrating L_Port 
waits for a response before beginning loop initialization.

Bandwidth The total transmission capacity of a link, cable, or system.

BB_Credit Buffer-to-buffer credit. The number of frames that can be transmitted to a 
directly connected recipient or within an arbitrated loop. Determined by 
number of available receive buffers. See also Buffer-to-buffer flow control, 
EE_Credit.

Beginning Running 
Disparity

The disparity at the transmitter or receiver when the special character 
associated with an ordered set is encoded or decoded. See also Disparity.

BER Bit Error Rate. Rate at which bits are expected to be received in error. 
Expressed as ratio of error bits to total bits transmitted. See also Error.

Bit synch-ronization The delivery of correctly clocked bits at the required BER. See also BER.

Block As applied to fibre channel, upper level application data that is transferred 
in a single sequence.

Broadcast Transmission of data from a single source to all devices in fabric, regardless 
of zoning. See also Multicast, Unicast.

Buffer-to-buffer flow 
control

Management of frame transmission rate between directly connected ports or 
within an arbitrated loop. See also BB_Credit.

Cascade Two or more interconnected fibre channel switches. For switches, a 
maximum of seven hops is recommended (no path longer than eight 
switches). 

Circuit Established communication path between ports. Consists of two virtual 
circuits that transmit in opposite directions. See also Link.

Class 1 A connection-oriented service that provides a dedicated connection between 
two ports, with notification of delivery or non-delivery.

Class 2 A multiplex and connectionless frame switching service between two ports, 
with notification of delivery or non-delivery. 
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Class 3 A connectionless frame switching service between two ports, without 
notification of delivery or non-delivery. Can also be used to provide a 
multicast connection between originator and recipients, with notification of 
delivery or non-delivery.

Class 4 Connection-oriented service that provides a virtual circuit between two ports, 
including notification of delivery or non-delivery. Allows fractional parts of 
the bandwidth to be used in a virtual circuit.

Class 6 Connection-oriented service that provides a multicast connection between 
the multicast originator and recipients, including notification of delivery or 
non-delivery.

Class F A connectionless service for control traffic between switches, with 
notification of delivery or non-delivery between the E_Ports.

Class of service A set of specific delivery characteristics and attributes for frame delivery.

CLS Close Primitive Signal. The protocol used by a port in an arbitrated loop to 
close a circuit. 

Code Balance The ration of one bit to the total number of transmitted bits.

Comma Unique pattern (either 1100000 or 0011111) used in 8b/10b encoding to 
specify character alignment within a data stream. See also K28.5.

Community (SNMP) Relationship between a group of SNMP managers and an SNMP agent, in 
which authentication, access control, and proxy characteristics are defined.

Connection Initiator A port that has originated a Class 1 dedicated connection and received a 
response from the recipient.

Connection Recipient A port that has received a Class 1 dedicated connection request and 
transmitted a response to the originator.

CRC Cyclic Redundancy Check. A check for transmission errors; included in 
every data frame.

Credit As applies to fibre channel, the number of receive buffers available for 
transmission of frames between ports. See also BB_Credit and EE_Credit.

CT_HDR Common transport header. A header that conforms to the Fibre Channel 
Common Transport (FC_CT) protocol.
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CT_IU Common transport information unit. An information unit that conforms to 
the Fibre Channel Common Transport (FC_CT) protocol.

Current Fill Word The fill word currently selected by the LPSM (loop port state machine). See 
also Fill Word.

Cut-through Switching technique that allows selection of a transmission route for a frame 
as soon as destination address is received. See also Route.

Data word Type of transmission word that occurs within frames. The frame header, data 
field, and CRC all consist of data words. See also Frame, Ordered set, 
Transmission word.

Defined 
configuration

The complete set of all zone objects defined in the fabric; can include multiple 
zone configurations. See also Enabled configuration, Zone configuration.

Disparity The relationship of ones and zeros in an encoded character. Neutral disparity 
indicates an equal number of each, positive disparity a majority of ones, and 
negative disparity a majority of zeros.

Distributed Fabrics The combined user’s guides for Extended Fabrics and Remote Switch. Not 
a software product.

DLS Dynamic Load Sharing. Dynamic distribution of traffic over available paths. 
Allows for redistribution when an Fx_Port or E_Port comes up or down.

Domain ID Unique identifier for the switch in a fabric. Usually automatically assigned 
by the switch, but can also be assigned manually. Can be any value between 
1 and 239. 

E_D_TOV Error Detect Time-out Value. Time allowed for round-trip transmission 
before recovery is initiated. Can also be defined as the minimum time an 
L_Port waits for sequence completion before initiating recovery. See also 
R_A_TOV.

E_Port Expansion Port. A switch port that has the ability to connect to a similar port 
on another switch, allowing creation of an interswitch link. See also ISL.

EE_Credit End-to-end credit. The number of receive buffers allocated by recipient port 
to originating port. Used by Class 1 and 2 services to manage exchange of 
frames across intervening ports in fabric. See also End-to-end flow control, 
BB_Credit.
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Enabled 
configuration

The currently enabled zone configuration. Only one configuration can be 
enabled at a time. See also Defined configuration, Zone configuration.

End-to-end   flow 
control

Governs flow of Class 1 and 2 frames between N_Ports. See also 
Buffer-to-buffer flow control, EE_Credit.

Error As applies to fibre channel, a missing or corrupted frame, time-out, loss of 
synchronization, or loss of signal. See also Loop failure.

Exchange As applies to fibre channel, a communication session between N_Ports 
involving the transmission of one or more related sequences, in one or both 
directions. See also Sequence.

Extended Fabrics Product that allows interconnection of fibre channel fabric over distances of 
up to 100 kilometers.

F_Port Fabric Port. A port that can transmit using fabric protocol and can interface 
over links. Can be used to connect N_Ports to a switch. See also FL_Port, 
Fx_Port.

Fabric A fibre channel network of two or more switches. Also called a “switched 
fabric.” See also SAN, Cascade.

Fabric name Unique 64-bit identifier assigned to each separate fabric. Communicated 
during login and port discovery.

Fabric OS Proprietary operating system on switches.

Fabric Watch Product that allows monitoring and configuration of fabric and switch 
elements.

FC-AL-3 The Fibre Channel Arbitrated Loop standard. Defined on top of FC-PH 
standards.

FC-FLA The Fibre Channel Fabric Loop Attach standard.

FCP Fibre Channel Protocol. Mapping of protocols onto fibre channel standard 
protocols. For example, SCSI FCP maps SCSI-3 onto fibre channel.

FC-PH-1, 2, 3 The Fibre Channel Physical and Signaling Interface standards.

FC-PI The Fibre Channel Physical Interface standard.
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FC-PLDA The Fibre Channel Private Loop Direct Attach standard. Applies to operation 
of peripheral devices on private loops.

FC-SW-2 The Fibre Channel Switch Fabric standard, second generation. Specifies 
tools and algorithms for interconnection and initialization of fibre channel 
switches. 

Fibre channel 
transport

Protocol service that supports communication between fibre channel service 
providers. See also FSP.

FIFO First In, First Out. May refer to a data buffer that follows the first in, first out 
rule.

Fill word A word transmitted to keep a fibre active. Either an idle or ARB ordered set.

FL_Port Fabric Loop Port. A port that can transmit under both fabric protocol and 
loop protocol. Can be used to connect NL_Ports to a switch. See also F_Port, 
Fx_Port.

FLOGI Fabric Login. Process by which a node makes a logical connection to fabric. 
Used by ports to determine if fabric is present, and if so to exchange service 
parameters with the fabric. See also PLOGI.

Frame Fibre channel structure used to transmit data. Consists of start-of-frame 
delimiter, header, any optional headers, data payload, cyclic redundancy 
check (CRC), and end-of-frame delimiter. There are two types: data frames 
and link control frames. Similar to the networking concept “packet”. See also 
Sequence, data word.

FRU Field Replaceable Unit. A component that can be replaced on site.

FS Fibre Channel Service. A service that is defined by fibre channel standards 
and exists at a well-known address. For example, Name Server is a fibre 
channel service. See also FSP.

FS_ACC Fibre channel services accept. The information unit used to indicate 
acceptance of a request for a fibre channel service.

FS_IU Fibre channel services information unit. An information unit that has been 
defined by a specific fibre channel service.

FS_REQ Fibre channel services request. A request for a fibre channel services 
function, or notification of a fabric condition or event.
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FS_RJT Fibre channel services reject. An indication that a request for fibre channel 
services could not be processed.

FSP Fibre Channel Service Protocol. The common protocol used for all fabric 
services, transparent to fabric type or topology. See also FS.

FSPF Fabric Shortest Path First. Routing protocol for fibre channel switches.

Full-duplex Mode of communication that allows a port to simultaneously transmit and 
receive frames. See also Half-duplex.

Fx_Port Fabric port that can operate either as F_Port or FL_Port. See also F_Port, 
FL_Port.

G_Port Generic Port. Port that can operate either as E_Port or F_Port. Ports are 
defined as G_Ports when disconnected or have not assumed specific function 
within fabric.

Gateway IP address assignment that provides translation for incompatible networks. 
For example, ATM gateway can connect a fibre channel link to an ATM 
connection.

GBIC Gigabit Interface Converter. Removable serial transceiver module that 
allows gigabit physical-layer transport for fibre channel.

Gbps Gigabits (1,062,500,000 bits) per second.

GBps Gigabytes (1,062,500,000 bytes) per second.

Half-duplex Mode of communication that allows a port to either transmit or receive 
frames, but not both at once. The only exception is link control frames, which 
can be transmitted at any time. See also Full-duplex.

Hard address The AL_PA that an NL_Port attempts to acquire during loop initialization.

Hardware 
Translative Mode

A method for achieving address translation. The following two hardware 
translative modes are available to a QuickLoop enabled switch:
• Standard Translative Mode: Allows public devices to communicate with 

private devices that are directly connected to the fabric.

• QuickLoop Mode: Allows initiator devices to communicate with private 
or public devices that are not in the same loop.
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HBA Host Bus Adapter. Interface card between a server or workstation bus and 
the fibre channel network. Similar to a network interface card.

Hub Fibre channel wiring concentrator that collapses loop topology into physical 
star topology. Nodes are automatically added when active and removed when 
inactive.

Idle Continuous transmission of an ordered set when no data is being transmitted 
to maintain an active fibre channel link and bit, byte, and word 
synchronization. See also Fill word.

IN_ID Initial identifier. The field in the CT_HDR where the port ID of the client 
originator of a Fibre Channel Services request.

Initiator Server or workstation that initiates communications with storage devices 
over a fibre channel network. See also Target.

IOD In Order Delivery. A parameter that, when set, guarantees that frames are 
delivered in-order if possible, and dropped if not.

IPA Initial process associator. An identifier associated with a process at an 
N_Port.

ISL Interswitch Link. Fibre channel link from the E_Port of one switch to E_Port 
of another. See also E_Port, Cascade.

Isolated E_Port A port that is online but not operational between switches due to overlapping 
domain ID or nonidentical parameters such as E_D_TOVs.

IU Information Unit. An individual set of information as defined by higher level 
process protocol definition, or upper-level protocol mapping.

JBOD Just a Bunch Of Disks. A number of disks connected in a single chassis to 
one or more controllers. See also RAID.

K28.5 Special 10-bit character used to indicate beginning of transmission words 
that perform fibre channel control and signaling functions. First seven bits 
are comma pattern. See also Comma.

L_Port Loop Port. Node or fabric port that can use loop protocol or fabric protocol. 
See also Non-participating mode, Participating mode.

Latency Time required to transmit a frame, from the time sent until time of arrival.
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Link As applies to fibre channel, a physical connection between two ports, 
consisting of both transmit and receive fibres. See also Circuit.

Link services Protocol for link-related actions.

LIP Loop Initialization Primitive. The signal used to begin initialization in a loop. 
Indicates either loop failure or resetting of a node. See also Loop 
initialization. 

LIS_HOLD_TIME The maximum period of time for a node to forward a loop initialization 
sequence

LM_TOV Loop Master Timeout Value. The minimum time that the loop master waits 
for a loop initialization sequence to return.

Login BB_Credit The number of receive buffers a receiving L_Port has available when a circuit 
is first established. Communicated through PLOGI, PDISC link services, or 
FLOGI.

Loop Circuit A temporary bidirectional communication path established between L_Ports.

Loop failure Loss of signal within a loop for any period of time, or loss of synchronization 
for longer than the time-out value. See also E_D_TOV.

Loop initialization Logical procedure used by L_Ports to discover environment. Can be used to 
assign AL_PA addresses, detect loop failure, or reset a node. See also LIP.

Loop_ID Hex value representing one of 127 possible AL_PA values in a loop. 

Looplet Set of devices connected in a loop to a port that is part of another loop.

LPSM Loop Port State Machine. Logical entity that performs arbitrated loop 
protocols and defines behavior of L_Ports when they require access to 
arbitrated loop.

LWL Long wavelength fibre optic cable. Based on 1300 nm lasers supporting 
1.0625 Gbps link speeds. Connectors are color-coded blue. See also SWL.

MIB Management Information Base. SNMP structure that provides configuration 
and device information to assist with device management.

Monitoring State The state in which a port is monitoring the flow of information for data 
relevant to the port.
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Multicast Transmission of data from a single source to a number of specified N_Ports. 
See also Broadcast, Unicast.

Multimode Fibre-optic cabling specification allowing up to 500 meters between devices.

N_Port Node Port. Port that can attach to a fibre channel port. See also NL_Port, 
Nx_Port.

NAA Network address authority. An identifier that indicates the format of a 
network address.

Name server Service of storing names, addresses, and attributes for up to 15 minutes, 
provided by a switch to other entities in fabric. Defined by fibre channel 
standards, and existing at a well-known address. Also called Simple Name 
Server, SNS, or directory service. See also FS.

NL_Port Node Loop Port. An N_Port that can use loop protocol. Used to connect 
equipment ports to fabric in loop configuration through FL_Port. See also 
N_Port, Nx_Port.

Node Fibre channel entity with one or more N_Ports or NL_Ports.

Node name Unique identifier for a node, communicated during login and port discovery.

Non-participating 
mode

Mode in which L_Port is inactive in loop and cannot arbitrate or send frames, 
but can retransmit received transmissions. Port enters mode if there are more 
than 127 devices in loop, and an AL_PA cannot be acquired. See also 
Participating mode.

Nx_Port Node port that can operate as either an N_Port or NL_Port.

Open Originator The L_Port that wins arbitration in an arbitrated loop and sends an OPN 
ordered set to the destination port, then enters the Open state.

Open Recipient The L_Port that receives the OPN ordered set from the open originator, and 
then enters the Open state.

Open State The state in which a port can establish a circuit with another port. A port must 
be in the Open state before it can arbitrate.

OPN Open Primitive Signal. The protocol used by a port that has won arbitration 
in an arbitrated loop to establish a circuit. 
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Ordered set A type of transmission word that occurs outside of frames, and is used to 
manage frame transport and differentiate fibre channel control information 
from data. See also Data word, Transmission word. Use 8b/10b mapping and 
begin with the K28.5 character. They include frame delimiters (which mark 
frame boundaries and describe frame contents), primitive signals (indicate 
events), and primitive sequences (indicate or initiate port states).

Participating mode Mode in which an L_Port in a loop has valid AL_PA and can arbitrate, send 
frames, and retransmit received transmissions. See also Non-participating 
mode.

Path Selection The selection of a transmission path through the fabric. Switches use the 
FSPF protocol.

Phantom    device Device not physically in a loop but logically included by phantom address.

Phantom address AL_PA value assigned to device not physically in loop. Also called phantom 
AL_PA.

PLOGI Port Login. Port-to-port login process by which initiators establish sessions 
with targets. See also FLOGI.

Point-to-point Two fibre channel devices connected by a direct link. See also Topology.

Port_Name Unique FC identifier for port, communicated during login and port discovery.

POST Power On Self Test. Series of self-tests run after a switch is rebooted or reset.

Private    NL_Port NL_Port that does not log into the fabric and communicates only with private 
NL_Ports in same loop.

Private device Device that supports arbitrated loop protocol and understands 8-bit 
addresses, but cannot log into fabric.

Private loop An arbitrated loop with no fibre channel attachment.

Protocol A defined method and standards for communication.

Public NL_Port NL_Port that logs into the fabric, can function within public or private loops, 
and can communicate with public or private NL_Ports.

Public device Device that supports arbitrated loop protocol, understands 8-bit addresses, 
and can log into fabric.
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Public loop An arbitrated loop attached to a switch.

QuickLoop Can indicate either the product that allows private devices within loops to 
communicate over the fabric with other devices, or the set of actual devices 
or looplets connected in a loop by QuickLoop technology. All devices in a 
QuickLoop share a single AL_PA space and behave as if they are in one loop.

R_A_TOV Resource Allocation Time-out Value. Maximum time a frame can be delayed 
in the fabric and still be delivered. See also E_D_TOV.

RAID Redundant Array of Independent Disks. Collection of disk drives that appear 
as a single volume to the server, and are fault-tolerant through mirroring or 
parity checking. See also JBOD.

Remote Switch Product that enables two switches to connect over an ATM connection. 
Requires compatible fibre channel-to-ATM gateways. Can be up to 10 
kilometers distance between each switch and respective gateway.

Request Rate The rate at which requests arrive at a servicing entity. See also Service Rate.

Route As applies to fabric, a communication path between two switches.Routing 
is the assignment of Class 2 or 3 frames to the most appropriate switch ports 
for the intended destinations. See also FSPF.

RR_TOV Resource Recovery Timeout Value. The minimum time a target device in a 
private loop must wait after a LIP before logging out a SCSI initiator. See 
also E_D_TOV, R_A_TOV.

RSCN Registered State Change Notification. Switch function that sends notification 
of fabric changes from the switch to specified nodes.

SAN Storage Area Network. Network of systems and storage devices that usually 
communicate using fibre channel protocols. See also Fabric.

Sequence A fibre channel structure containing one or more frames transmitted in a 
unidirectional manner between N_Ports. See also Exchange, Frame.

Service Rate The rate at which an entity can service requests. See also Request Rate.

SI Sequence Initiative.

Single mode Fibre-optic cabling standard that provides for distances of up to 10 kilometers 
between devices.
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SNMP Simple Network Management Protocol. Internet management protocol that 
does not rely on underlying communication protocols and can therefore be 
made available over other protocols, such as UDP/IP. Uses IP for network 
layer functions and UDP for transport layer functions, or TCP/IP for both. 
See also Community (SNMP).

SNMPv1 The original standard for SNMP, now labeled v1.

SNS Simple Name Server. See Name server.

Switch A combination of hardware and firmware that routes frames according to 
fibre channel protocol. Switches can have G_Ports, E_Ports, F_Ports, and 
FL_Ports.

Switch Domain_ID Unique identifier for a switch, used in routing frames. Usually automatically 
assigned by the switch, but can be manually assigned by administrator.

Switch name Arbitrary name assigned to switch by administrator. See also Switch 
Domain_ID.

Switch Port Port on a switch. Switch ports can be E_Ports, F_Ports, or FL_Ports.

SWL Short wavelength fiber-optic cable. Based on 850 nm lasers supporting 
1.0625 Gbps link speeds. Connectors are color-coded black. See also LWL.

Target Storage device that receives communications from a server or workstation 
over a fibre channel network. See also Initiator.

Tenancy The time from when a port wins arbitration in a loop until the same port 
returns to the monitoring state. Also referred to as loop tenancy.

Throughput The rate of data flow achieved within a cable, link, or system. See also 
Bandwidth.

Topology As applies to fibre channel, the structure of the fibre channel network and 
the resulting possible communication paths. There are three fibre channel 
topologies: point-to-point, fabric, and arbitrated loop.

Transfer State A state in which a port can establish circuits with multiple ports without 
reentering the arbitration cycle for each circuit. This state can only be 
accessed by an L_Port in the Open state.

Translative mode Mode in which public devices can communicate with private devices across 
fabric.Translates 8-bit to 24-bit addresses. 
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Transmission 
Character

A 10-bit character encoded according to the rules of the 8b/10b algorithm. 
See also 8b/10b encoding, Transmission word.

Transmission Word Group of four transmission characters, totaling 40 bits. Two types: data words 
and ordered sets. See also Data word, Ordered set, Transmission character.

Trap (SNMP) Message sent by SNMP agent to inform SNMP management station of 
critical error. See also SNMP.

Tunneling Technique for enabling source and destination hosts to communicate when 
on same type of network but connected by a different type of network.

U_Port Universal Port. Switch port that can operate as G_Port, E_Port, F_Port, or 
FL_Port. A port is defined as a U_Port if not connected or if it has not 
assumed a specific function in the fabric.

UDP User Datagram Protocol. A protocol that runs on top of IP and provides port 
multiplexing for higher layer protocols.

ULP Upper Layer Protocol. Protocol that runs on top of fibre channel. Typical 
upper layer protocols: SCSI, IP, HIPPI, IPI.

ULP_TOV Upper Level Timeout Value.The minimum time that a SCSI ULP process 
waits for SCSI status before initiating ULP recovery.

Unicast Transmission of data from a single source to single destination. See also 
Broadcast, Multicast.

Web Tools Product that provides a graphical interface for monitoring and managing 
individual switches or entire fabrics from standard workstations.

Well-known address As applies to fibre channel, a logical address stored on the switch and defined 
by fibre channel standards as being assigned to a specific function.

WWN World Wide Name. Identifier that is unique world-wide. Each entity in a 
fabric has a separate WWN.

Xmitted Close State The state in which an L_Port cannot send messages, but can retransmit 
messages within the loop. A port in the XMITTED CLOSE state cannot 
attempt to arbitrate.
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Zone Set of hosts and devices attached to same fabric and having access 
permission, including RSCNs and user data, to each other. Entities inside a 
zone are not visible to entities outside the same zone, even if the outside 
entities are in another zone. Equivalent to network term “virtual LAN”.

Zone configuration A specified set of zones. Enabling a zone configuration enables all zones in 
that configuration. See also Defined configuration, Enabled configuration.

Zoning Product that allows partitioning of fabric into logical groupings of devices. 
See also Zone.
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